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Résumé
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CHAPITRE 1. INTRODUCTION

1.1. RED HAT JBOSS BRMS

Red Hat JBoss BRMS est une plateforme de gestion de décisions open source combinant la gestion des
règles d'entreprise et Complex Event Processing. BRMS automatise les décisions d'entreprise et met la
logique métier à la disposition de l'ensemble des activités.

Red Hat JBoss BRMS utilise un référentiel centralisé où toutes les ressources sont stockées. Cela
assure une certaine homogénéité, de la transparence, et la possibilité de conduire une audit à travers les
activités. Les utilisateurs commerciaux peuvent ainsi modifier la logique commerciale sans l'assistance
du personnel TI.

Business Resource Planner est inclus comme aperçu technologique dans cette version.

Rapporter un bogue

1.2. CAS D'UTILISATION : GESTION DES DÉCISIONS DANS LE
SECTEUR DES ASSURANCES AVEC JBOSS BRMS

BRMS comprend un engine de règles de haute performance qui vient du projet Drools, un référentiel de
règles et des outils d'authoring faciles à utiliser du projet Guvnor, des extensions d'engine de règles
Complex Event Processing du projet Fusion. Il comprend également OptaPlanner, un solutionneur de
problèmes de planification complexes, comme aperçu technologique.

Le marché de la consommation d'assurances est extrêmement concurrentiel, et il est impératif que les
clients bénéficient de services globaux, efficaces et concurrentiels lorsqu'ils font l'expérience d'une
solution de devis d'assurance en ligne. Un assureur a augmenté ses revenus à partir de sa solution de
devis en ligne, en incitant les visiteurs à acheter d'autres solutions pertinentes aux produits dont il s'agit
pendant le processus de cotation.

JBoss BRMS avait été intégré à l'infrastructure de fournisseurs d'assurance de façon à ce que
lorsqu'une demande d'assurance était traitée, BRMS était consulté, et des produits complémentaires
appropriés étaient présentés dans la cotation d'assurance :

CHAPITRE 1. INTRODUCTION
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Figure 1.1. Cas d'utilisation : prise de décision dans le secteur des assurances

BRMS fournit la fonctionnalité de gestion de décision, c'est-à-dire la détermination automatique des
produits à présenter aux demandeurs selon les règles définies par les analystes. Les règles sont
implémentées sous forme de tables de décision, de façon à pouvoir être facilement comprises et
modifiées sans avoir besoin de support supplémentaire de la part des services informatiques.

Rapporter un bogue
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CHAPITRE 2. GUIDE DE DÉMARRAGE RAPIDE DE RED HAT
JBOSS BRMS
Dans cette section, nous téléchargeons, installons et exécutons BRMS de Red Hat JBoss avec un
minimum d'instructions. Pour obtenir des informations supplémentaires sur les étapes et sur les autres
méthodes possibles d'installation, passez cette section et continuer la lecture de ce guide.

Ces instructions assument que vous possédez la version Java prise en charge au minimum sur votre
système. Un serveur Red Hat JBoss EAP existant n'est pas requis car le programme d'installation en
installera un si on ne peut pas le détecter.

Procédure 2.1. Guide de démarrage rapide de BRMS

1. Télécharger le programme d'installation BRMS à partir de access.redhat.com.

2. Démarrez le programme d'installation par la commande suivante :

java -jar jboss-brms-installer-VERSION.GA-redhat-MINOR.jar

3. Faire défiler les étapes d'installateur de GUI en notant le nom d'utilisateur/et mot de passe pour
accéder à l'application BRMS après l'installation.

4. Après une installation réussie, dans une invite de commandes, placez-vous dans le dossier où
vous avez installé EAP BRMS.

5. Démarrez le serveur BRMS par la commande suivante :

bin/standalone.sh

6. Ouvrir un navigateur et connectez-vous au Business Central en naviguant dans 
http://localhost:8080/business-central/. Connectez-vous en utilisant la paire nom
d'utilisateur/mot de passe pour accéder à l'application BRMS que vous avez créée lors de
l'installation.

Vous avez maitenant réussi l'installation et vous pouvez exécuter BRMS. Vous pouvez maintenant
procéder à ce qui suit :

Pour en savoir davantage sur les roles: Section 3.3, « Définir les rôles »

Créer des utilisateurs supplémentaires : Section 3.4, « Création des utilisateurs »

Créer une règle Hello World : Chapitre 5, Exemple de règle Hello World

Trouver les directives d'installation du programme d'installation : Installation Guide

Rapporter un bogue
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CHAPITRE 3. INSTALLATION

3.1. TÉLÉCHARGER BRMS POUR JBOSS EAP DE RED HAT JBOSS

1. Aller dans le portail Red Hat Customer Portal et connectez-vous.

2. Sélectionner Downloads → Red Hat JBoss Middleware → Download Software.

3. À partir du menu déroulant Product, sélectionner BRMS Platform.

4. À partir du menu Version, sélectionner la version 6.0.2.

5. Sélectionner Red Hat JBoss BRMS 6.0.2 Deployable for EAP 6.1.1 puis cliquer sur 
Download.

Rapporter un bogue

3.2. INSTALLATION DE RED HAT JBOSS BRMS DANS RED HAT
JBOSS ENTERPRISE APPLICATION PLATFORM

Red Hat JBoss BRMS peut être installé dans JBoss Enterprise Application Platform 6.1.1. Pour installer
le package déployable dans une plateforme Red Hat JBoss Enterprise Application Platform qui n'est pas
encore configurée, procédez ainsi :

1. Déplacez l'archive zip téléchargée dans le répertoire d'accueil de Red Hat JBoss Enterprise
Application Platform (EAP_HOME; le répertoire jboss-eap-6.1 ).

2. Décompressez l'archive zip téléchargée : assurez-vous qu'elle soit mise dans le répertoire
EAP_HOME (jboss-eap-6.1).

AVERTISSEMENT

Cette étape doit être exécutée par le même compte d'utilisateur utilisé pour
installer EAP. Ce compte ne doit pas être un compte superutilisateur.

3. Il est nécessaire de remplacer les fichiers qui existent déjà dans le répertoire EAP_HOME avec
leur version d'archive zip téléchargée. Lorsque vous êtes invité à le faire, acceptez de remplacer
les fichiers d'origine.

Pour installer le package déployable d'une plateforme Red Hat JBoss Enterprise Application Platform
déjà configurée, procédez ainsi :

1. Télécharger l'archive zip et préparez-vous à faire fusionner les fichiers ensemble dans le
répertoire d'accueil de Red Hat JBoss Enterprise Application Platform (EAP_HOME; le
répertoire jboss-eap-6.1).

2. Décompressez l'archive zip téléchargée ; mais ne remplacez pas tous les fichiers. Faîtes
fusionner manuellement les fichiers suivants dans le répertoire EAP_HOME (jboss-eap-6.1).


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jboss-eap-6.1/domain/configuration/*

jboss-eap-6.1/standalone/configuration/*

jboss-eap-6.1/modules/layers.conf

jboss-eap-6.1/bin/product.conf

AVERTISSEMENT

Assurez-vous que cette étape ait été exécutée par le même compte
d'utilisateur utilisé pour installer EAP. Ce compte ne doit pas être un compte
superutilisateur.

3. Veillez à ce que la cible EAP n'inclue pas de déploiement ayant un nom qui risque d'entrer en
conflit. Copier le dossier jboss-eap-6.1/standalone/deployments dans le répertoire
EAP_HOME à partir de la distribution BRMS.

4. Assurez-vous bien qu'aucune couche de module EAP se prénome BRMS et copier le dossier 
jboss-eap-6.1/modules/system/layers/brms dans le dossier EAP 6.1.1.

Dans Red Hat Enterprise Linux, vous pouvez utiliser la commande suivante pour extraire le fichier
BRMS zip et le merger dans votre répertoire EAP correctement en une seule étape :

Exemple 3.1. La commande unzip

Rapporter un bogue

3.3. DÉFINIR LES RÔLES

Avant de démarrer le serveur et de vous connecter au Business Central, vous devrez créer des comptes
utilisateur. Cette section décrit les différents rôles qui sont utilisés dans Red Hat JBoss BRMS :

admin : les utilisateurs ayant un rôle admin sont les administrateurs de l'application. Les
administrateurs peuvent gérer les utilisateurs, les référentiels (les créer et les cloner) et avoir un
accès total pour effectuer des changements dans l'application. Les admins ont accès à toutes
les régions du système.

analyst : un rôle d'analyste a accès à toutes les fonctions de haut niveau des projets modèles.
Cependant, l'accès Authoring → Administration n'est pas disponible aux utilisateurs ayant un
role d'analyste. Certaines fonctions de bas niveau qui ciblent les développeurs, comme la vue



unzip -u jboss-brms-VERSION-redhat-VERSION-deloyable-eap6.x.zip -d 
EAP_HOME_PARENT_DIR

unzip -u jboss-brms-VERSION-redhat-VERSION-deployable-eap6.x.zip -d 
/home/john/myEAP/

CHAPITRE 3. INSTALLATION
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Deployment → Artifact Repository sont cachées à ce role. Cependant, le bouton Build & 
Deploy est accessible au role d'analyste quand celui-ci utilise l'éditeur de projet.

NOTE

Saisir les rôles mentionnés ci-dessus lors du processus de création d'un utilisateur.

Rapporter un bogue

3.4. CRÉATION DES UTILISATEURS

Pour commencer à ajouter de nouveaux utilisateurs, vous devez exécuter le script add-user.sh sur un
système Unix ou le fichier add-user.bat sur un système Windows dans le répertoire bin EAP.

1. Exécuter ./add-user.sh sur un système Unix ou add-user.bat sur un système Windows à partir du
répertoire bin.

2. Saisir b pour sélectionner un utilisateur d'application à l'invite type d'utilisateur, et appuyer sur
Enter.

3. Accepter le domaine (realm) par défaut (ApplicationRealm): en appuyant sur Enter.

4. À l'invite du nom utilisateur, saisir un nom utilisateur et le confirmer. Par exemple : 
helloworlduser.

5. Créer le mot de passe utilisateur à l'invite du mot de passe et saisir à nouveau le mot de passe.
Par exemple : Helloworld@123.

NOTE

Le mot de passe doit comporter au moins 8 caractères et contenir des caractères
alphabétiques majuscules et minuscules (par exemple A-Z, a-z), au moins un
caractère numérique (par exemple 0-9) et au moins un caractère spécial (p. ex.
~! @ # $ % ^ * () - _ + =).

6. Saisir une liste de rôles séparée par des virgules dont l'utilisateur aura besoin sur invite des
rôles (se reporter à Section 3.3, « Définir les rôles »).

Les utilisateurs de Business Central doivent posséder le rôle analyst ou le rôleadmin.

7. Confirmer que vous souhaitez ajouter l'utilisateur.

8. Saisir oui à la prochaine invite (pour activer le clustering dans le future si possible)

Rapporter un bogue

3.5. INSTALLATION DE RED HAT JBOSS BRMS DANS RED HAT
JBOSS WEB SERVER

Le package déployable standard est fourni pour que les clients puissent installer Red Hat JBoss BRMS
6 dans un serveur d'applications existant. La procédure suivante fournit des instructions pour
l'installation sur une instance existante de Red Hat JBoss Web Server 2.0.1

Procédure 3.1. Installer un package déployable standard
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Procédure 3.1. Installer un package déployable standard

1. Pour télécharger le fichier zip du package déployable standard de Red Hat Customer Support
Portal, allez dans https://access.redhat.com et connectez-vous.

2. Sélectionner Downloads → Red Hat JBoss Middleware → Download Software.

3. À partir du menu déroulant Product, sélectionner BRMS Platform.

4. À partir du menu déroulant Version, sélectionner la version du produit.

5. Sélectionner le package Red Hat JBoss BRMS 6.0.2 Deployable for all 
supported containers puis cliquer sur Download.

6. Extraire l'archive téléchargée pour créer les archives zip suivantes :

jboss-brms-engine.zip

jboss-brms-manager.zip

7. Extraire business-central.war de l'archive jboss-brms-manager.zip et la copier dans 
tomcat7/webapps/.

8. Supprimer l'extension .war du business-central.war de façon à ce que le répertoire soit
dorénavant nommé business-central.

9. Définir les utilisateurs et les rôles dans tomcat7/conf/tomcat-users.xml comme indiqué
ci-dessous :

  <role rolename="admin"/>
  <role rolename="analyst"/>
  <user username="user" password="password" roles="admin,analyst"/>

10. Modifier le fichier web.xml du répertoire tomcat7/webapps/business-central/WEB-INF
en décommentant les entrées marquées TOMCAT-JEE-SECURITY. Par exemple :

Doit être décommenté ainsi :

<!-- TOMCAT-JEE-SECURITY -->
    <!--
    <init-param>
      <param-name>org.uberfire.auth.scheme</param-name>
      <param-
value>org.uberfire.security.server.auth.JACCAuthenticationScheme</pa
ram-value>
    </init-param>
    -->

<!-- TOMCAT-JEE-SECURITY -->

    <init-param>
      <param-name>org.uberfire.auth.scheme</param-name>
      <param-
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11. Copier le fichier kie-tomcat-integration-VERSION.jar à partir de business-
central/WEB-INF/lib de la distribution BRMS dans tomcat7/lib.

12. Copier le fichier slf4j-api-VERSION.jar et le fichier slf4j-ext-VERSION.jar de 
business-central/WEB-INF/lib de la distribution BRMS dans tomcat7/lib.

13. Télécharger le fichier ci-dessous et le mettre dans le répertoire tomcat7/lib.

javax.security.jacc-api.jar

14. Ajouter la déclaration de Valve Tomcat dans tomcat7/conf/server.xml (dans l' <hôte> qui
convient):

<Valve className="org.kie.integration.tomcat.JACCValve"/>

15. Renommer org.uberfire.security.auth.AuthenticationSource dans 
org.uberfire.security.auth.AuthenticationSource-ORIGIN et 
org.uberfire.security.auth.AuthenticationSource-TOMCAT-JEE-SECURITY dans
org.uberfire.security.auth.AuthenticationSource à l'intérieur de business-
central/WEB-INF/classes/META-INF/services

16. Démarrer le serveur JBoss Web Server en exécutant startup.sh dans le répertoire 
tomcat7/bin.

17. Naviguez vers http://localhost:8080/business-central dans un navigateur web.

18. Connectez-vous avec le nom d'utilisateur et le mot de passe donnés dans le fichier tomcat-
users.xml où vous avez défini les rôles d'utilisateur.

Rapporter un bogue

3.6. DÉMARRAGE DU SERVEUR

Si vous avez installé BRMS par le programme d'installation ou par le package d'installation EAP6, vous
pouvez maintenant démarrer votre serveur dans un des deux modes.

NOTE

Si vous avez installé BRMS en utilisant la version standard déployable sur le serveur Red
Hat Java Web Server, les instructions de téléchargement et d'installation contiennent les
instructions de démarrage du serveur. Vous pouvez ignorer la discussion qui suit.

Le script de démarrage par défaut, standalone.sh qui fait partie de Red Hat JBoss BRMS est
optimisé dans un souci de performance. Pour exécuter votre serveur en mode de performance, suivez
ces instructions :

1. Sur ligne de commande, déplacez-vous dans le répertoire $SERVER_HOME/bin/.

value>org.uberfire.security.server.auth.JACCAuthenticationScheme</pa
ram-value>
    </init-param>

./startup.sh
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2. Dans un environnement Unix, exécuter :

./standalone.sh

Dans un environnement Windows, exécuter :

./standalone.bat

Red Hat JBoss BRMS est aussi fourni avec un script séparé, standalone-secure.sh optimisé pour
la sécurité. Ce script applique une politique de sécurité par défaut qui protège contre une vulnérabilité de
sécurité connue.

NOTE

Il est conseillé que l'environnement de production utilise le script standalone-
secure.sh.

AVERTISSEMENT

L'utilisation d'un gestionnaire de sécurité impose une sensible baisse de
performance dont vous devez être conscient. Le compromis entre sécurité et
performance s'impose en tenant compte des circonstances individuelles. Voir
Section 3.7, « Java Security Manager et Gestion de performance ».

Pour exécuter le serveur en mode sécurisé avec ce script, vous devrez faire ce qui suit : 

1. Sur ligne de commande, déplacez-vous dans le répertoire $SERVER_HOME/bin/.

2. Dans un environnement Unix, exécuter :

./standalone-secure.sh

Dans un environnement Windows, exécuter :

./standalone-secure.bat

Rapporter un bogue

3.7. JAVA SECURITY MANAGER ET GESTION DE PERFORMANCE

Tel que mentionné précédemment, en activant JSM, le gestionnaire de sécurité Java, à sandbox,
l'évaluation de scripts MVEL dans BRMS ajoute une charge à la performance dans des environnements
à forte charge. On doit conserver à l'esprit les environnements et les marqueurs de performance
lorsqu'on déploie une application BRMS. Utilisez les instructions suivantes pour déployer des
applications BRMS sécurisées et performantes.

Dans des environnements de charge élevée où la performance est critique, il est recommandé


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de seulement déployer des applications qui ont été développées sur d'autres systèmes et
adéquatement évaluées. Il est également recommandé de ne pas créer des utilisateurs avec le
rôle d'analyste sur de tels systèmes. Si ces précautions sont respectées, il est plus sûr de laisser
JSM désactivé sur ces systèmes afin d'éviter toute dégradation de performance.

Dans les environnements de test et de développement sans charges élevées ou dans des
environnements où la règle et le processus de création sont exposés à des réseaux externes, il
est recommandé d'avoir JSM activé afin d'obtenir une meilleure sécurité d'évaluation
correctement isolée (sandboxed) de MVEL.

Autoriser les utilisateurs ayant un rôle d'analyste à se connecter dans la console Business Central avec
JMS désactivé n'est pas sécurisé, ni recommandé.

Rapporter un bogue
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CHAPITRE 4. CONNECTEZ-VOUS À BUSINESS CENTRAL
Connectez-vous à Business Central une fois que le serveur aura démarré.

1. Naviguer dans http://localhost:8080/business-central via navigateur web. Si l'interface utilisateur
est configurée pour exécuter à partir d'un nom de domaine, substituer localhost par le nom de
domaine. Par exemple http://www.example.com:8080/business-central.

2. Connectez-vous à l'aide des informations d'identification qui ont été créées lors de l'installation.
Par exemple: User = helloworlduser et mot de passe = Helloworld@123.

Rapporter un bogue
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CHAPITRE 5. EXEMPLE DE RÈGLE HELLO WORLD
Pour démontrer les fonctionnalités de base de JBoss BRMS, cet exemple vous montrera comment
définir le projet Hello World avec une règle métier Hello World.

Vous devrez procéder ainsi :

1. Créer un référentiel Hello World dans le référentiel Artifact.

2. Créer un projet Hello World.

3. Créer une règle Hello World.

4. Générer et déployer le projet.

Rapporter un bogue

5.1. CRÉATION D'UNE STRUCTURE DE RÉFÉRENTIEL

Tous les actifs de l'entreprise vivent dans des référentiels qui se trouvent dans des unités
organisationnelles, correspondant à des répertoires dans le référentiel Artifact. Par défaut, le référentiel
artifact ne contient pas n'importe quelles unités organisationnelles. Donc, pour pouvoir créer votre
propre business process, vous devez créer une unité d'organisation dans le référentiel Artifact et un
référentiel (Git) dedans. Le référentiel peut contenir votre projet. Un projet peut contenir une structure de
package arbitraire, qui permet de structurer son contenu dans la structure logique du « répertoire ». Un
package peut contenir vos ressources d'entreprise (pour plus d'informations sur le référentiel Artifact,
consulter le Guide utilisateur de Red Hat JBoss BRMS)

Pour créer la structure du référentiel, procédez ainsi :

1. Ouvrir Business Central dans votre navigateur web (en cas d'exécution locale
http://localhost:8080/business-central) et connectez-vous en tant qu'utilisateur avec le rôle 
admin (helloworlduser).

2. Créer une unité organisationnelle dans le référentiel Artifact :

a. Aller dans Authoring → Administration.

b. Dans le menu Perspective, cliquer sur Organizational Units → Manage Organizational
Units.

c. Dans la vue Organizational Unit Manager, cliquer sur Add.

Dans la boîte de Add New Organizational Unit affichée, définir les propriétés d'unité
et cliquer sur le bouton OK:

Nom : helloworld

Propriétaire : helloworlduser

3. Créer un nouveau référentiel dans l'unité organisationnelle helloworld :

a. Aller dans Authoring → Administration.

b. Dans le menu perspective, cliquer sur Repositories → New repository.

Guide de démarrage

14

https://bugzilla.redhat.com/enter_bug.cgi?cf_environment=Build+Name%3A+22694%2C+Getting+Started+Guide-6.0-1%0ABuild+Date%3A+07-04-2015+15%3A10%3A44%0ATopic+IDs%3A%0A23737-592525+%5BSpecified%5D&comment=Title%3A+Hello+World+rule+example%0A%0ADescribe+the+issue%3A%0A%0A%0ASuggestions+for+improvement%3A%0A%0A%0AAdditional+information%3A&product=JBoss+BRMS+Platform+6&component=Documentation&version=6.0.2


c. Dans la boîte de dialogue Create Repository affichée, définir les propriétés du
référentiel :

Nom du référentiel : helloworldrepo

Unité organisationnelle : helloworld

4. Aller dans Authoring → Project Authoring.

5. Dans Project Explorer qui se trouve dans la boîte d'unité organisationnelle, sélectionner 
helloworld, et dans la zone déroulante du référentiel, sélectionner helloworldrepo.

Figure 5.1. Sélectionner le référentiel helloworldrepo qui se trouve dans l'unité
organisationnelle helloworld de Project Explorer

6. Créer un projet dans le référentiel helloworld :

a. Dans le menu perspective, cliquer sur New Item → Project.

b. Dans la boîte de dialogue Create new affichée, définir les propriétés du projet :

Nom du projet (nom du projet): HelloWorld

Chemin : default://master@helloworldrepo/

c. Dans la boîte de dialogue New Project Wizard, définir les propriétés maven du projet.
Appuyer sur la touche Enter après chaque entrée.

ID Group : org.brms

ID Artifact : HelloWorld

ID Version : 1.0

d. Cliquer sur Terminé.

Rapporter un bogue
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5.2. CRÉATION D'UNE RÈGLE MÉTIER

Les règles métier sont définies sous forme d'énoncés si-alors : quand un énoncé est true, alors quelque
chose a lieu (par exemple si une personne a plus de 18 ans, elle peut accéder à un contenu spécifique).
Les règles de contenu sont stockées dans les fichiers DRL.

Pour définir la règle de métier helloworldrule dans le projet HelloWorld, procédez ainsi :

1. Dans Project Explorer, sélectionner l'unité organisationnelle helloworld, le référentiel 
helloworldrepo, le projet HelloWorld, et le package default.

NOTE

Assurez-vous de bien sélectionner le package default. Si vous sélectionnez le
mauvais package, le déploiement échouera.

2. Créer le fichier DRL :

a. Dans le menu perspective, cliquer sur New Item → DRL file.

b. Dans la boîte de dialogue Create New, définir le nom de la ressource en tant que 
helloworldrule et vérifier que le chemin de destination soit bien 
default://master@helloworldrepo/HelloWorld/src/main/resources.

c. Cliquez sur Valider.

3. Dans l'éditeur DRL qui affiche le fichier helloworldrule.drl, définir la règle :

Cette règle ne définit aucune condition (Si), c'est à dire qu'elle sera toujours sur true par défaut
quand on l'appelle à exécution, et la phrase Hello World! s'affichera.

4. Cliquer sur le bouton Save.

5. Une invite Save this item apparaît. Saisir Check-in comment et cliquer sur Save.

NOTE

Le commentaire d'enregistrement correspond à une description courte du genre
de changement que vous venez d'effecteur et doit être saisi à chaque fois qu'une
ressource est sauvegardée.

Rapporter un bogue

5.3. GÉNÉRATION ET DÉPLOIEMENT

Générer le projet complet et déployez-le dans le serveur d'exécution :

rule "helloworldrule"
ruleflow-group "helloworldgroup"
when 
then
 System.out.println("Hello World!");
end
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1. Dans le menu principal de Business Central, aller dans Authoring → Project Authoring.

2. Dans Project Explorer, chercher le projet Hello World.

3. Ouvrir le project dans l'éditeur du project  : dans le menu perpective, cliquer sur Tools →
Project Editor.

4. Vérifier que les bonnes informations de project soient affichées dans Project Screen et
cliquer sur le bouton Build & Deploy qui se trouve dans le coin en haut et à gauche de la
vue Project View.

Figure 5.2. Éditeur de projet avec des propriétés de projet helloWorld

Une notification verte apparaît dans la partie supérieure de l'écran pour vous informer que le projet a été
généré et est disponible pour l'instanciation. Noter que la version précédente du déploiement 
helloWorld est remplacée par la nouvelle version avec la tâche de règle d'entreprise (Business Rule
Task). Pour garder les deux déploiements, changer le numéro de version du projet dans l'éditeur de
projet.

Rapporter un bogue
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CHAPITRE 6. RED HAT JBOSS DEVELOPER STUDIO
Red Hat JBoss Developer Studio est l'environnement de développement intégré de JBoss (IDE) basé
sur Eclipse et disponible à partir du portail de support client de Red Hat à https://access.redhat.com.
JBoss Developer Studio fournit des plug-ins avec des outils et des interfaces pour Red Hat JBoss BRMS
et Red Hat JBoss BPM Suite. Ces plugins sont basés sur la version communautaire de ces produits.
Ainsi, le plugin de BRMS s'appelle le plugin Drools et le plugin BPM Suite s'appelle le plugin jBPM.

Voir la documentation Red Hat JBoss Developer Studio pour obtenir les instructions d'installation et de
configuration.

Rapporter un bogue

6.1. INSTALLATION DES PLUG-INS D'UN JBOSS DEVELOPER STUDIO

AVERTISSEMENT

Topic 9495, Revision 591882 failed validation and is not included in this build.

6.2. DÉFINIR LE RUNTIME DE DROOLS

Pour utiliser le plug-in JBoss BRMS dans Red Hat JBoss Developer Studio, il est nécessaire de définir le
runtime.

Un runtime est une collection de fichiers jar qui représentent une version spécifique du logiciel et fournit
les bibliothèques nécessaires à la compilation et à l'exécution des ressources d'entreprise.

Extraire les fichiers runtime jar qui se trouvent dans l'archive jboss-brms-engine.zip de l'archive zip
JBoss BRMS Generic Deployable (et non pas l'archive zip déployable EAP6) (disponible Red Hat
Customer Portal).

Procédure 6.1. Configurer le Runtime de BRMS

1. À partir du menu JBoss Developer Studio, sélectionner Window et cliquer sur Preferences.

2. Sélectionner Drools → Installed Drools Runtimes.

3. Cliquer sur Add...; fournir un nom de nouveau runtime, puis cliquer sur Browse pour naviguer
vers le répertoire où le runtime se situe. Cliquer sur OK pour enregistrer le runtime sélectionné
dans JBDS.

4. Indiquer que le runtime que vous avez créé est le runtime Drools par défaut en cliquant sur la
case adjacente.

5. Cliquer sur OK. Si vous avez des projets existants, une boîte de dialogue vous indiquera de
démarrer à nouveau JBoss Developer Studio pour mettre le Runtime à jour.

Rapporter un bogue


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6.3. CONFIGURATION DU SERVEUR JBOSS BRMS

JBoss Developer Studio peut être configuré pour exécuter Red Hat JBoss BRMS Server.

Procédure 6.2. Configurer le Serveur

1. Ouvrir la vue Drools en sélectionnant Window → Open Perspective → Other et sélectionner 
Drools puis cliquer OK.

2. Ajouter la vue de serveur en sélectionnant Window → Show View → Other... et en
sélectionnant Server → Servers.

3. Ouvrir le Menu de serveur en cliquant à droite le panneau de serveurs et en sélectionnant New
→ Server.

4. Définir le serveur en sélectionnant JBoss Enterprise Middleware → JBoss Enterprise
Application Platform 6.1+ et en cliquant sur Next.

5. Configurer le répertoire d'accueil en cliquant sur le lien , puis sur le bouton Browse. Recherchez
et sélectionnez le répertoire d'installation de JBoss EAP 6.1.1 avec JBoss BRMS installé.

6. Donnez un nom au serveur dans le champ Name, assurez-vous que le fichier de configuration
est défini à et cliquer sur Finish.

Rapporter un bogue

6.4. IMPORTER LES PROJETS D'UN RÉFÉRENTIEL GIT DANS JBOSS
DEVELOPER STUDIO

JBoss Developer Studio peut être configuré pour se connecter à un référentiel central de ressources Git.
Le référentiel est l'endroit où sont stockés les versions de règles, les modèles, les fonctions et des
processus. Ce référentiel Git doit déjà être défini par le Workbench de KIE.

Les utilisateurs peuvent soit importer un référentiel local Git, soit cloner un référentiel Git distant.

Procédure 6.3. Importer un référentiel local Git

1. Démarrer le serveur Red Hat JBoss BRMS (s'il n'est pas déjà en cours d'exécution) en
sélectionnant le serveur à partir de l'onglet Serveur et en cliquant sur le bouton Start.

2. Sélectionner File → Import... et naviguez dans le fichier Git. Ouvrir le dossier Git et sélectionner
Projects from Git puis cliquer Next.

3. Sélectionner la source du référentiel en tant que Existing local repository et cliquer sur Next.
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Figure 6.1. Informations sur le référentiel Git

4. Sélectionner le référentiel qui doit être configuré à partir de la liste de référentiels disponibles.

5. Importer le projet en tant que projet général dans la prochaine fenêtre et cliquer sur Next.
Nommez ce projet et cliquer sur Finish.

Procédure 6.4. Cloner un référentiel GIT distant

1. Démarrer le serveur Red Hat JBoss BRMS (s'il n'est pas déjà en cours d'exécution) en
sélectionnant le serveur à partir de l'onglet Serveur et en cliquant sur le bouton Start.

2. Démarrer en même temps le serveur Secure Shell, s'il n'est pas déjà en cours d'exécution, en
utilisant la commande suivante. La commande est spécifique à Linux ou Mac. Sur ces plates-
formes, si sshd a déjà démarré, cette commande échouera et vous pourrez ignorer cette étape.

3. Sélectionner File → Import... et naviguez dans le fichier Git. Ouvrir le dossier Git et sélectionner
Projects from Git puis cliquer Next.

4. Sélectionner la source du référentiel en tant que Clone URI et cliquer sur Next.

5. Saisir les détails du référentiel Git dans la prochaine fenêtre et cliquer sur Next.

/sbin/service sshd start
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Figure 6.2. Informations sur le référentiel Git

6. Sélectionner la branche que vous souhaitez importer dans la prochaine fenêtre et cliquer sur
Next.

7. On vous donnera alors l'option de définir le stockage local pour ce projet. Saisir (ou
sélectionnez) un répertoire non-vide, apporter des modifications de configuration et cliquer sur
Next.

8. Importer le projet en tant que projet général dans la prochaine fenêtre et cliquer sur Next.
Nommez ce projet et cliquer sur Finish.

Rapporter un bogue

6.5. CRÉATION D'UN PROJET DROOLS

Procédure 6.5. Créer un nouveau projet Red Hat JBoss Developer Studio
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1. À partir du menu principal, sélectionner File → New → Project.

Sélectionner Drools → Drools Project et cliquer sur Next.

2. Saisir un nom pour le projet dans la case Project name: et cliquer sur Next.

NOTE

JBoss Developer Studio donne l'option d'ajouter un exemple de fichier
HelloWorld au projet. Accepter cette valeur par défaut en cliquant sur Next afin
de tester l'échantillon de projet par les étapes suivantes :

3. Sélectionner le temps d'exécution (ou utiliser la valeur par défaut).

4. Sélectionner un code compatible avec Drools 6.0.x. Saisir GroupID, un ArtifactID, et
une Version, et cliquer sur Finish.

5. Pour tester le projet, cliquer à droite sur le fichier Java qui contient la méthode principale, et
sélectionner Run → run as → Java Application.

La sortie s'affichera dans l'onglet de console.

Rapporter un bogue
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CHAPITRE 7. BUSINESS RESOURCE PLANNER
Business Resource Planner est disponible en aperçu technologique dans Red Hat JBoss BRMS.
Business Ressource Planner est un engine de planification léger, encastrable qui optimise les
problèmes de planification. Il aide les programmeurs Java TM à résoudre efficacement les problèmes de
planification, et il allie optimisation heuristique et métaheuristique à des scores très efficace des calculs.

Les planificateurs proposent des solutions à des cas variés comme ceux qui suivent :

Employee/Patient Rosters. Les planificateurs aident à la création de planning horaire à
l'intention des infirmières qui souhaitent garder la trace des plans de gestion d'un malade au lit.

Educational Timetables. Les planificateurs aident à programmer des leçons, des cours, des
examens, et des présentations de conférences.

Shop Schedules : les planificateurs suivent les progrès de lignes de montage de voitures, de
lignes de montage de machines, et aident à la création des plannings de la main d'oeuvre.

Cutting Stock : les planificateurs réduisent la consommation de ressources comme le papier ou
l'acier.

Rapporter un bogue

7.1. INSTALLATION DU BUSINESS RESOURCE PLANNER

1. Naviguez dans Red Hat Customer Portal et connectez-vous par vos informations d'identification
utilisateur.

2. Sélectionner Downloads → Red Hat JBoss Middleware → Download Software.

3. À partir du menu Products, sélectionner BPM Suite.

4. Dans le menu déroulant Version, sélectionner la version de prod 6.0.2.

5. Sélectionner Red Hat JBoss BRMS 6.0.2 Business Resource Planner puis cliquer
sur Download.

Rapporter un bogue

7.2. EXÉCUTER LES EXEMPLE DE BUSINESS RESOURCE PLANNER

1. Sur ligne de commande, déplacez-vous dans le répertoire examples/.

2. En environnement Unix, exécuter la commande suivante :

./runExamples.sh

En environnement Windows, exécuter la commande suivante :

./runExamples.bat

3. Sélectionner un exemple de l'application Examples GUI qui s'ouvre et l'exécuter dans votre IDE
favori.
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Rapporter un bogue
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